Logic Pro 9 Advanced Music Production
Creating and Producing Professional Music

David Dvorin

Apple Certified
Level 2 certification

DVD-ROM with media and lesson files included
Apple Pro Training Series

Logic Pro 9
Advanced Music Production

David Dvorin
with Robert Brock
## Contents at a Glance

Getting Started ................................................................. 1

### Setup and Production

**Lesson 1**  
Speeding Up Your Workflow ................................................. 9  
**Lesson 2**  
Working with Time and Pitch .............................................. 47

### Creating Your Own Sounds with Software Instruments

**Lesson 3**  
Synthesis with the ES2 Synthesizer ................................ 105  
**Lesson 4**  
Sampling with the EXS24 mkII ................................................. 133  
**Lesson 5**  
Sound Design with Sculpture ................................................. 163  
**Lesson 6**  
Building Drum Sounds with Ultrabeat ................................... 179

### Editing

**Lesson 7**  
Working with the Arrangement ............................................. 199  
**Lesson 8**  
Advanced Audio Editing ...................................................... 247  
**Lesson 9**  
Advanced MIDI Editing ...................................................... 299

### Mixing

**Lesson 10**  
Managing the Mix ............................................................ 333  
**Lesson 11**  
Controlling Signal Flow ...................................................... 357  
**Lesson 12**  
Controlling the Mix ............................................................ 383

### Advanced Topics

**Lesson 13**  
Working with Surround ....................................................... 413  
**Lesson 14**  
MIDI Processing in the Environment ........................................ 443  
**Lesson 15**  
Working with Notation ........................................................ 481  
**Lesson 16**  
Working with Picture .......................................................... 535  
**Lesson 17**  
Moving Projects Between Logic and Pro Tools ......................... 561  

Index .............................................................. 576
# Table of Contents

Getting Started ........................................ 1

## Setup and Production

### Lesson 1
- Speeding Up Your Workflow ................................. 9
- Creating Your Own Template ................................. 10
- Customizing the Interface .................................. 14
- Using Key Commands ......................................... 23
- Accessing the Tool Menu ..................................... 29
- Saving a Project Template .................................... 36
- Opening and Creating Projects Automatically .......... 36
- Backing Up and Transporting Your Setup ................. 38
- Lesson Review ............................................... 45

### Lesson 2
- Working with Time and Pitch ................................. 47
- Creating Your Own Apple Loops with the Apple Loops Utility 48
- Using the Time and Pitch Machine ......................... 56
- Using Pitch Correction ........................................ 63
- Using Flex Time ................................................ 68
- Using Speed Fades ............................................. 89
- Making Tempo Adjustments with Varispeed ............... 91
- Working with Rubato Passages ............................. 93
- Lesson Review ............................................... 102

## Creating Your Own Sounds with Software Instruments

### Lesson 3
- Synthesis with the ES2 Synthesizer ......................... 105
- Understanding the User Interface ......................... 106
- Exploring the Oscillator Waveforms ...................... 107
- Using Oscillator Modulation to Create Interesting Sounds 111
- Sculpting Your Sound Using the Filters .................. 114
- Using Modulation ............................................ 118
- Exploring the Output/Processing Section ................. 130
- Lesson Review ............................................... 131

### Lesson 4
- Sampling with the EXS24 mkII ............................. 133
- Creating Sampler Instruments .............................. 134
## Lesson 9
Advanced MIDI Editing ........................................... 299
- Using Aliases .................................................. 300
- Working with Region Parameters ......................... 303
- Selecting MIDI Events for Editing ......................... 317
- Using Transform Functions .................................. 318
- Separating MIDI Events ...................................... 328
- Lesson Review .................................................. 330

## Mixing
### Lesson 10
Managing the Mix .................................................. 333
- Importing Channel Strips and Data ......................... 334
- Working with the Mixer ....................................... 336
- Creating Production Notes .................................... 342
- Panning Stereo Tracks ....................................... 344
- Switching the Contents of the Plug-in Window ............ 346
- Changing Plug-in Locations .................................. 348
- Using a Plug-in’s Extended Parameters .................... 350
- Using Mixer Groups .......................................... 351
- Lesson Review .................................................. 355

### Lesson 11
Controlling Signal Flow .......................................... 357
- Using Aux Channels as Submixes ......................... 358
- Applying Send Effects to Submixes ....................... 361
- Using Side Chain Effects .................................... 362
- Positioning Sends Pre or Post Channel Strip Controls ... 367
- Incorporating External Effects Processors ............... 373
- Bouncing in Place ............................................. 376
- Lesson Review .................................................. 381

### Lesson 12
Controlling the Mix .............................................. 383
- Automating an Aux Channel ............................... 384
- Copying Automation Data Between Tracks ............... 389
- Scaling Automated Values .................................. 391
- Applying Automation to Multiple Tracks at Once ....... 392
- Using Control Surfaces ...................................... 394
- Lesson Review .................................................. 410

## Advanced Topics
### Lesson 13
Working with Surround ......................................... 413
- Configuring Logic for Surround ............................ 414
| Lesson 14 | MIDI Processing in the Environment .................................. 443 |
| Lesson 15 | Working with Notation ...................................................... 481 |
| Lesson 16 | Working with Picture ............................................................ 535 |
| Lesson 17 | Moving Projects Between Logic and Pro Tools .......................... 561 |

| Lesson 14 | Navigating Within the Environment .................................... 444 |
| Lesson 15 | Creating Notation ............................................................... 482 |
| Lesson 16 | Setting Up Synchronization ................................................ 536 |
| Lesson 17 | Exporting a Project ............................................................. 562 |

| Lesson 14 | Creating Environment Objects ........................................... 447 |
| Lesson 15 | Entering Notes Using Graphic Input .................................... 483 |
| Lesson 16 | Using Markers to Spot the Movie ........................................ 543 |
| Lesson 17 | Importing Projects into Pro Tools ....................................... 567 |

| Lesson 14 | Creating Signal Chains ...................................................... 458 |
| Lesson 15 | Entering Notes Using Step Input ........................................ 492 |
| Lesson 16 | Importing Media ............................................................... 546 |
| Lesson 17 | Importing Audio Files into Logic ....................................... 573 |

| Lesson 14 | Using Touch Tracks Objects ............................................... 469 |
| Lesson 15 | Working with Guitar Notation ............................................ 494 |
| Lesson 16 | Positioning Events on the Timeline .................................... 551 |
| Lesson 17 | Lesson Review ................................................................. 575 |

| Lesson 15 | Working with Text ............................................................. 502 |
| Lesson 16 | Working with Drum Notation ............................................. 513 |
| Lesson 17 | Creating Scores and Parts ................................................ 524 |

| Lesson 16 | Creating Chord Charts ....................................................... 505 |
| Lesson 17 | Lesson Review ................................................................. 532 |

| Lesson 17 | Transcribing a Performance ............................................... 517 |

Index ................................................................. 576
Getting Started

We are lucky to live during one of the most exciting periods in the music production industry. Just a few short years ago, you would need a studio filled with synthesizers, hardware effects processors, mixing consoles, and expensive multitrack tape machines to accomplish what you can now do in a small project-based environment with a computer, an audio interface, and the right software. It’s a good time to be a musician.

*Apple Pro Training Series: Logic Pro 9 Advanced Music Production* is intended to show experienced composers, arrangers, and producers how to enhance their skills by working with real projects in real-world scenarios. You’ll learn how to increase the efficiency of your production workflow and accelerate editing tasks. You’ll work on refining your mixing techniques, manipulating tempo and pitch, creating notated parts and scores, mixing for surround sound, and working with video and film. You’ll unlock the limitless potential of Logic’s groundbreaking software instruments by creating your own sounds from scratch.

Whether you’re tweaking a song structure, applying effects processing, or editing audio and MIDI tracks, this book will give you the insider tips that will make your time with Logic Pro 9 more productive and more creative.
The Methodology

This book is written for those who already have a working knowledge of Logic Pro. (Beginning or less-experienced Logic users should read Apple Pro Training Series: Logic Pro 9 and Logic Express 9 by David Nahmani.) Composers, audio engineers, and music producers currently working with Logic Pro will have the most to gain from reading this book.

The book is divided into five sections:

▶ Lesson 1 lays the foundation by helping you customize your Logic workflow. You’ll create an environment that will increase your efficiency on your own projects as well as on the exercises in the book. Lesson 2 reveals Logic’s deep feature set for manipulating time and pitch, including the new Flex Time feature.

▶ In Lessons 3 through 6, you’ll create your own sounds on Logic’s most advanced software instruments: ES2, EXS24 mkII, Sculpture, and Ultrabeat. Gaining an understanding of these powerful synthesizers and samplers will bring a wealth of musical resources to your sessions.

▶ In Lessons 7 through 9, you’ll shape your tracks into an arrangement. With Logic Studio’s MIDI and audio editing tools, you can refine the sound and structure of your composition, correcting production problems and making the most of your best takes.

▶ A composition is only as good as it sounds, which makes mixing and mastering your arrangement an essential part of the creative process. Lessons 10 through 12 guide you in taking your composition to the final level, using Logic Pro’s Mixer, automation, control surface support, and effects processing to bring the highest degree of production quality to your creative output.

▶ For many projects, Logic Pro will be an all-inclusive working environment that takes composers and producers from musical idea to final recording. But there are times when you need to get your ideas on paper or when you’re using your musical skills to serve a visual image. Lesson 13 provides a foundation for developing your surround sound mixing skills by using Logic’s extensive new surround support. In Lesson 14 you’ll create objects in the Environment to process MIDI data in all sorts of interesting ways. Lesson 15 shows you how to use Logic Pro’s extensive notation capabilities to create musical parts and scores. In Lesson 16 you’ll explore Logic Pro’s power as a film and video scoring tool. Finally, in Lesson 17 you’ll learn how to best transport sessions between Logic and other DAWs, enabling you to freely collaborate with studios running other software applications.
About the Apple Pro Training Series

*Apple Pro Training Series: Logic Pro 9 Advanced Music Production* is part of the official training series for Apple Pro applications developed by experts in the field. The lessons are designed to let you learn at your own pace. You’ll find that this book explores many advanced features and offers tips and techniques for using the latest version of Logic.

Although each lesson provides step-by-step instructions for creating a specific project, there’s room for exploration and experimentation. It is recommended that you follow the book from start to finish or at least complete the lessons in each part of the book in order. Each lesson concludes with a review section summarizing what you’ve covered.

System Requirements

Before beginning to use *Apple Pro Training Series: Logic Pro 9 Advanced Music Production*, you should have a working knowledge of your computer and its operating system. Make sure that you know how to use the mouse, navigate standard menus and commands, and also open, save, and close files. If you need to review these techniques, see the printed or online documentation included with your system.

For the basic system requirements for Logic Pro 9, go to www.apple.com/logicstudio/specs.

**NOTE** If your display resolution is less than 1440 x 900, the included lesson files will display differently than shown in the book. Even so, you will be able to follow the lessons as described.

Copying the Logic Lesson Files

The DVD-ROM provided with this book includes folders that contain the lesson files used in this course. Each lesson has its own folder. You must have a standard installation of Logic Pro 9 on your hard disk to perform the exercises in this book.

To install the Logic project files:

1. Insert the *APTS_Advanced Logic 9* DVD into your DVD drive.

2. On your desktop, double-click the *APTS_Advanced Logic 9* icon to view the disk contents.

3. Drag the Advanced Logic 9_Files folder from the DVD to the Music folder on your hard disk.
About the Apple Pro Training Series

Apple Pro Training Series: Logic Pro 9 Advanced Music Production is both a self-paced learning tool and the official curriculum of the Apple Pro Training and Certification Program.

Developed by experts in the field and certified by Apple, the series is used by Apple Authorized Training Centers worldwide and offers complete training in all Apple Pro products. The lessons are designed to let you learn at your own pace. Each lesson concludes with review questions and answers summarizing what you’ve learned, which can be used to help you prepare for the Apple Pro Certification Exam.

For a complete list of Apple Pro Training Series books, see the ad at the back of this book, or visit www.peachpit.com/apts.

Apple Pro Certification Program

The Apple Pro Training and Certification Programs are designed to keep you at the forefront of Apple’s digital media technology while giving you a competitive edge in today’s ever-changing job market. Whether you’re an editor, graphic designer, sound designer, special effects artist, or teacher, these training tools are meant to help you expand your skills.

Upon completing the course material in this book, you can become an Apple Certified Pro by taking the certification exam at an Apple Authorized Training Center. Certification is offered in Final Cut Pro, Motion, Color, Soundtrack Pro, DVD Studio Pro, Shake, and Logic Pro. Certification as an Apple Pro gives you official recognition of your knowledge of Apple’s professional applications while allowing you to market yourself to employers and clients as a skilled, pro-level user of Apple products.

For those who prefer to learn in an instructor-led setting, Apple offers training courses at Apple Authorized Training Centers worldwide. These courses, which use the Apple Pro Training Series books as their curriculum, are taught by Apple Certified Trainers and balance concepts and lectures with hands-on labs and exercises. Apple Authorized Training Centers have been carefully selected and have met Apple’s highest standards in all areas, including facilities, instructors, course delivery, and infrastructure. The goal of the program is to offer Apple customers, from beginners to the most seasoned professionals, the highest-quality training experience.

For more information, please see the ad at the back of this book, or to find an Authorized Training Center near you, go to training.apple.com.
Resources

*Apple Pro Training Series: Logic Pro 9 Advanced Music Production* is not intended as a comprehensive reference manual, nor does it replace the documentation that comes with the application. For more information about Apple Logic Pro 9, refer to these sources:

- Logic Pro 9 User Manual: Accessed through the Logic Pro 9 Help menu, the User Manual contains a complete description of all the features.
- Apple’s website: www.apple.com

Acknowledgments

The authors wish to give sincere and humble thanks to all of the talented musicians who provided material for use in this edition of the book:

- Tom Langford for his song “I Was Raised”
- Grant Levin for his composition “A Blues for Trane”
- Rocky Winslow and Randy McKean for playing on “Georgie the Spider”
- Composer Joe LoDuca, engineer Scott Davidson, and the folks of Electric Entertainment for the use of the score and footage from the Leverage series
- Caesar Filori and Wide Band Network for providing “Anatomy of a Human Bomb”
- Brandon Jaehne for use of “Gibsonia”
This page intentionally left blank
Lesson Files
Advanced Logic 9_Files > Lessons > 04_EXS24_Start.logic

Media
Advanced Logic 9_Files > Media > EXS24

Time
This lesson takes approximately 60 minutes to complete.

Goals
Build new sampler instruments from audio regions
Assign pitch mapping and tuning to zones
Create loop points for sustaining sounds
Use groups to assign common parameters to multiple zones
Use filters and modulation to change the character of sampled material
Route output of specific groups for individual processing
Lesson 4

Sampling with the EXS24 mkII

A sampler is an extremely versatile tool. Essentially, it allows you to map digital audio files, or *samples*, across pitch ranges for triggering via MIDI. It does this by dynamically changing the playback speed of the samples in real time to match the pitch specified by the MIDI note value.

Individual samples are referenced and mapped within a *sampler instrument*. In this lesson, you will explore the abilities of the EXS24 mkII by creating unique sampler instruments using specific audio regions from the Arrange window.
**Creating Sampler Instruments**

Traditionally, new sampler instruments are produced by first creating a blank sampler instrument, and then adding and mapping individual samples one by one, building it from the ground up. However, one of the new features in Logic Pro 9 is the ability to use a single command to automatically create a new EXS24 mkII track loaded with a new sampler instrument wrapped around a selected audio region in the Arrange window. This makes it especially easy to extend the creative possibilities of audio files, placing under your fingertips the ability to trigger and process.

1. Choose File > Open.

2. In the file selector dialog, navigate to Music > Advanced Logic 9_Files > Lessons and open 04_EXS24_Start.logic.

3. Use the Mute tool to unmute the Vox Note region on Track 1.

4. Play the project, listening to the Vox Note audio region.

   You will use this recording of a singer holding a single pitch for your first sampler instrument.

5. Stop playback.

6. Go to the beginning of the project.

7. In the Arrange area, select the Vox Note region, if it’s not already selected.

8. From the local Audio menu, choose Convert Regions to New Sampler Track.

   The Convert Regions to New Sampler Track dialog appears.

   Here, you can set how the selected audio region will be initially mapped within the new sampler instrument. Samples are mapped within zones, which contain settings controlling how the sample will be played back, including key ranges.
9 Select Create Zones From Regions, if it’s not selected already.

This will create a single zone that references the Vox Note audio region (as outlined at the bottom of the dialog).

You can also set the pitch range of the zone that will be created, as specified by the Trigger Note Range menus (low to high). Since only a single audio region was selected (you can also select multiple), it will only utilize the lowest trigger note to map the region.

10 Click the first Trigger Note Range pop-up menu and choose C3 (60).

This will create a new zone at C3, right in the middle of the keyboard.

11 Click OK.

A new EXS24 track (named Vox Note) is created below the original track, along with a new MIDI region. This new region contains a held C3 note that triggers the newly mapped audio file for the same duration as the original audio region. Note that the original region is muted. The new MIDI region in effect replaces the original one in the arrangement.
12 Play the project, listening to the new Vox Note MIDI region played through the EXS24.

The playback sounds identical to before.
This new zone will be automatically velocity mapped; the harder you strike the key, the louder the file playback.

13 Press the C3 on your MIDI keyboard at varying velocities, listening to the result.

The Vox Note audio file plays as long as you hold down the key, changing volume (amplitude) along with your keyboard velocity.

**Using the EXS24 Instrument Editor**
Let’s take a look inside the newly created sampler instrument, with the goal of exploring the creative potential offered by the EXS24. Sampler instruments are edited within the EXS24 Instrument Editor, which is accessible from within the EXS24 interface.

1 In the Inspector, double-click the EXS24 in the Arrange channel strip to open the EXS24 interface.
The EXS24 Parameter window opens, with the newly created sampler instrument, Vox Note, displayed. You will be working with the parameters in this window later on in the lesson, but for now, you will use it to quickly access the EXS24 Instrument Editor.

2 Click the Edit button, located at the top right.

The EXS24 Instrument Editor opens.

For now, you can close the window to save some screen real estate.

3 Close the EXS24 Parameter window (not the EXS24 Instrument Editor).

The EXS24 Instrument Editor has two views: Zones and Groups. You are currently looking at the Zones view (more on Groups later), as indicated by the selected button at the top left.
The top portion of the EXS24 Instrument Editor is called the Parameters area, and it displays the settings of each sample referenced by the sampler instrument. The bottom portion of the window displays how each sample is mapped to various pitches, represented by the keyboard at the bottom of the window. As you can see, a new zone, named Vox Note.1 was created, mapped to C3 on the keyboard.

When you create a sampler instrument with the Convert Regions to New Sampler Track command, the zone created is without range—that is, only mapped to a single pitch. You can, of course, extend the zone’s range to map the audio file to multiple pitches. This is done either by changing settings within the Key Range columns of the Parameters area, or by dragging directly on the zone in the bottom area.

4 Within the Key Range parameters, double-click the Hi field and enter c4. Press Return.

```
<table>
<thead>
<tr>
<th>Key Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lo</td>
</tr>
<tr>
<td>C3</td>
</tr>
</tbody>
</table>
```

The zone extends in range to the right, from C3 to C4.

5 In the bottom area of the EXS24 Instrument Editor, drag the zone’s left border to the left, extending the range to C2.

```
C1
C2
C3
C4
```

6 Play the C2 to C4 keys on your MIDI keyboard, listening to the result.

The pitch (and speed) of the sample shifts up and down, mapped in relation to your MIDI keyboard input.

**NOTE** You can also create new sampler instruments by choosing New from the EXS24 Instrument Editor’s Instrument menu, or by clicking the Edit button on the EXS24 interface when an instrument isn’t currently loaded. This creates a blank sampler instrument where you can manually add zones by choosing New Zone or Load Multiple Samples from the Zones menu. You can also create new zones by dragging and dropping audio files from the Logic Bin or Browser, or even the Finder.
If you have perfect pitch, you might have noticed that the sung note is a little flat compared to standard tuning (A440). This wouldn't be a problem if this was the only instrument used in the project, but if other instruments will be played at the same time, it would sound out of tune. Using the zone’s Pitch parameters in the Instrument Editor, you can compensate for tuning discrepancies (Coarse equaling semitones, and Fine equaling cents, or 1/100th of a semitone).

The best way to tune a zone by hand is by inserting a Tuner plug-in on the EXS24 channel, monitoring the results as you adjust parameters.

7 Click the top insert slot of the new Vox Note (EXS24) channel, and select Metering > Tuner > Stereo.

The Tuner opens.

8 While watching the Tuner readout, hold down the C3 key on your MIDI keyboard and drag the zone’s Fine parameter upwards to about 28 cents (the Tuner’s readout should bob around the 12 o’clock position).

The sample plays back in tune in relation to standard tuning.

9 Close the Tuner window.
Creating Loop Points

Looping is a technique that stems from the day when samplers had tiny memory stores (by today’s standards) in which to load samples. Many sounds start off with complex attacks but soon settle into a more or less steady waveform. By repeating this “settled” area, a sample can be sustained indefinitely without using valuable memory space. Even with modern software samplers that have access to gigabytes of memory (like the EXS24), looping is a useful technique to create sustaining sounds out of material that is otherwise quite short, like the audio file you are working with in this exercise.

By default, this editor only displays some of the Zone parameters, while hiding others, including the Loop parameters. You can select the parameters that you want to display within the View menu.

1. Click the local View menu and choose View All.

![View menu]

All Zone parameters are displayed, including the Loop parameters.

NOTE ► Depending on the size of your EXS24 Instrument Editor window, you might need to scroll to the right to view the Loop parameters.

In order to enable looping, you first need to select the Loop On box.

2. In the Loop parameters, click the Loop On box.

Although you could enter start and end times (by sample number) in the parameters area, this would be arbitrary and counterintuitive. It is much easier to select an area on the waveform itself by using the Sample Editor.
3 In the Audio File parameters for the zone, click the small disclosure triangle to the right of the audio file name and choose Open in Sample Editor.

The Sample Editor opens, displaying the referenced audio file, Vox Note.aif.

**NOTE** You most likely will need to expand the Sample Editor window to do the following exercise. If you have limited screen real estate, you can minimize the EXS24 Instrument Editor window, temporarily storing it in your Dock.

**TIP** Double-clicking an audio file within a zone also opens the audio file in the Sample Editor.

By default, the Sample Editor displays bars/beats in its timeline. It is much more helpful to view the timeline when setting loop points in samples (1 sample = 1 ÷ sample rate per second). This will correspond to the numerical display within the EXS24 Instrument Editor.

**NOTE** Samples as a measurement of time is not to be confused with the term samples, mentioned earlier in the chapter. The latter is another way of saying “digital audio files,” while the former refers to the tiny components that make up a digital waveform.

4 From the local View menu, choose Samples.
The timeline is now displayed in samples.

The trick to setting loop points is to find a sustaining portion within the audio file that can be repeated without interruption. In order to make smooth edits, it is necessary to make selections that do not interrupt the waveform above or below the zero axis (thereby creating an audible click). When Snap Edits to Zero Crossings is enabled within the Sample Editor, all new selections will be justified to the nearest point the waveform crosses the zero axis.

5 From the local Edit menu, choose Snap Edits to Zero Crossings.

6 Using the help tags, select an area from approximately 28800 to 91900 samples (refer to the following illustration).

You can audition your selection by selecting the Prelisten and Cycle buttons at the top of the Sample Editor.
7 Click the Prelisten and Cycle buttons to listen to your selection looping.

8 Click the Prelisten button, stopping playback.

**TIP** Your loop points may sound a bit rough at first, but with further massaging, you can create a smoother result. This is done by zooming in on the start and end loop points and fine-tuning the selection while auditioning.

Now that you’ve identified the area you want to be looped, you need to set the start and end loop points to the zone in the EXS24 Instrument Editor.

9 From the Sample Editor’s local Edit menu, choose Selection > Sample Loop.

The Sample Loop lane within the Sample Editor displays the selected area in green.

10 Close the Sample Editor.

The results of your selection appear within the Loop parameters of the EXS24 Instrument Editor.
11 Hold down a C3 on your MIDI keyboard, listening to the result.

The sample plays, now looping the selected area for as long as you hold down the key. To aid you in helping to smooth out the repeating loop’s start and end points, you can apply a short crossfade. This is similar to how you smooth region transitions in the Arrange window.

12 In the Loop parameters, double-click the Xfade field and enter 30. Press Return.

There is also an option to have the crossfade be equal powered, which creates an exponential curve with a 3 db boost in volume in the middle to compensate for the dip in volume that normally occurs within a linear crossfade.

13 In the Loop parameters, click the E. Pwr box to enable it.

14 Hold down a C3 on your MIDI keyboard, listening to the result.

The sample plays, smoothly looping the selected area for as long as you hold down the key.

Using the Parameter Window

After a sampler instrument is loaded, the triggered sounds are further refined and processed by the global playback parameters located on the interface of the EXS24 mkII itself. These parameters are nearly identical to the sound processing functionality of a synthesizer, allowing you to further shape your sampler instrument sounds.

1 In the EXS24 Instrument Editor window, click the EXS24 button.
The EXS24 Parameter window (interface) opens. This offers a convenient way to access the EXS24 playback parameters without having to go back to the channel strip.

2 Close the EXS24 Instrument Editor.

A Save dialog appears.

3 Click Save.

Now look at the EXS24’s interface. Note that the EXS24 shares many interface characteristics with the ES2 synthesizer covered in Lesson 3. It has filter, output, modulation routing, and modulation source sections in similar places within the interface.
In this exercise, you will use the amplitude envelope to change the character of the Vox Note sampler instrument to that of a swelling choir-like pad that decays slowly. In the EXS24, Envelope 2 is hardwired to amplitude, and it controls the dynamics of how the sound is shaped over time for each key pressed.

4 In the controls for Envelope 2, drag the Attack slider upwards to about midway (about 820 ms).

**TIP** You can split the Attack controls of both Envelopes 1 and 2 to create a range. This intensity range is modulated via note velocity, wherein high values trigger the sound more quickly (represented by the lower half of the control), and low values trigger the sound more slowly (represented by the upper half of the control).

5 In the controls for Envelope 2, drag the Release slider upwards to about midway (about 820 ms).

6 Hold down a chord between C2 and C4 on your MIDI keyboard, listening to the result. You should hear a swelling, sustained choir sound, based off of the original audio file, Vox Note.aif.

7 From the preset menu, choose Save Setting As.

8 In the file selector dialog, name the preset Vox Note and then click Save.

9 Close the EXS24 window
Creating Multiple Zones from Region Transients

In the previous exercises, you created a single zone sampler instrument from an audio file in the Arrange window. Using a similar technique, you can create a sampler instrument with multiple zones based off of detected transients in the audio file. This is especially useful when dealing with rhythmic material such as drum and percussion loops that have clear transients.

In the following exercises, you will create a new sampler instrument from a basic drum loop and explore ways to extend and transform the sound using the EXS24 playback parameters and routing flexibility.

1. Use the Mute tool to mute the new Vox Note region (Track 2).

2. Select the Basic Drums track (Track 3).

3. Use the Mute tool to unmute the Basic Drums regions on Track 3.

4. Play the project, listening to the Basic Drums region to become familiar with the material.

5. From the Arrange window’s local Audio menu, choose Convert Regions to New Sampler Track.

   The Convert Regions to New Sampler Track dialog appears.

6. Select Create Zones From Transient Markers.

   ![Convert Regions to New Sampler Track](image)

   **NOTE**  When you select to create zones by transient markers, Logic performs a quick transient detection similar to the one performed when you activate Flex view for the first time. The number of detected transients is displayed in the info area at the bottom of the Convert Regions to New Sampler Track dialog.

7. Click OK.

   A new EXS24 track (also named Basic Drums) is created, along with a new MIDI region. This new region contains multiple note events that trigger each of the created zones in order, and for the same duration as the original audio region, replacing the original audio region in the arrangement.
NOTE ➤ This is similar to using the Slicing Flex mode, wherein an audio region is chopped up according to its transients.

8 Play the project, listening to the new Basic Drums MIDI region played through the EXS24.

The playback sounds identical to before.

9 In the Inspector, double-click the EXS24 in the Arrange channel strip to open the EXS24 interface.

10 Click the Edit button, located at the top right.

The EXS24 Instrument Editor opens, displaying the multiple zones created from transients.
As you can see within the Parameters area, each transient from the original audio file is mapped chromatically to MIDI pitches C3 through G#3.

11 Play the C3 through G#3 keys on your MIDI keyboard, listening to the result.

When playing the associated MIDI pitches on the keyboard, you hear each individual slice. However, the slice only plays for as long as you hold down the key, and it can sound truncated if you let go before the slice plays out in its entirety. In order for the sample to play back its complete length irrespective of the key release, you need to have 1Shot enabled within the Zone parameters.

12 Choose Select All from the EXS24 Instrument Editor’s Edit menu.

13 On any of the selected zones, click the 1Shot box to enable it for all.

14 Play the C3 through G#3 keys on your MIDI keyboard, listening to the result.

The slices play through in their entirety.

Although this provides an effective way to trigger the drums as a performance instrument, let’s explore additional playback parameters within the EXS24 Instrument Editor to further process the sound.

15 Click in the background of the EXS24 Instrument Editor to deselect all zones.

16 In the Parameters area, Command-click the zones mapped to C#3, D#3, and G#3 to select them.

   **TIP** To use your MIDI controller to select zones, choose Zone > Select Zone of Last Played Key.

17 Click the Reverse box for one of the selected zones to enable it for all selected zones.
Play the C#3, D#3, and G#3 keys on your MIDI keyboard, listening to the result. The samples play back in reverse.

Close the EXS24 Instrument Editor window.

Click Save in the Save dialog that appears.

**Using Filters and Modulation to Process the Sound**

Just like you used the ES2 synthesizer to process the oscillators’ signal, you can use EXS24’s filter and extensive modulation options to process the sampler instrument you created. In fact, the EXS24’s filter and modulation router directly mirror the ones in the ES2, with the exception of only offering a single filter, instead of a pair.

The filter in the EXS24 is a multimode filter, offering high-pass, low-pass, and band-pass modes. In order to take advantage of its sound-shaping properties, you first need to switch it on.

Click the filter on/off button located at the right side of the filter section.

**NOTE** Having an on/off switch for the filter enables you to quickly audition sounds with and without the filter’s influence. It also is worth noting that when the filter is active, it takes up more processor power, so it is a good idea to switch it off when you don’t need it.
Now that the filter is switched on, you can apply filter settings to shape the sound.

2 Do the following with the EXS24’s filter settings (refer to the illustration below to double-check):

- Click the 6 db low-pass (LP) filter mode/slope button to gradually attenuate frequencies above the cutoff frequency.
- Drag the Cutoff knob to about 68%.
- Drag the Resonance knob to about 45%, accentuating the cutoff frequency by applying a gain boost.
- Click the Fat button, enabling you to retain the low frequencies that are naturally diminished by high-resonance settings.
- Drag the Drive knob to about 20% distorting the filter and adding harmonics.

![Filter Settings Illustration]

Now that you’ve created your filter settings, it’s time to hear the result.

3 Play the C3 through G#3 keys on your MIDI keyboard, listening to the result of the filter settings.

You can further expand on the filter’s sound-shaping properties by applying modulation to the cutoff frequency. The goal is to create a surging filter sweep that is timed to the tempo of the song. You can do this by using the EXS24’s modulation router, which is nearly identical to the ES2’s modulation router, except that it calls the parameter that will be changed dynamically the destination instead of the target.

4 In the third (empty) slot in the modulation router, choose filter cutoff (Flt Cutoff) as the destination (Dest), and LFO1 as the source (Src).

![Modulation Router Illustration]

5 Drag the Intensity slider to about +7.7%.
6 Select the top sawtooth setting for LFO1’s waveform.

7 Drag LFO1’s Rate knob to the left, setting it to 1/8.

This will create a filter sweep for every eighth note, no matter what the tempo of the project is.

**NOTE** The EXS24’s LFO1 is polyphonic with its own envelope generator, just like the ES2.

Now it’s time to test your modulation routing. Because it’s tempo-dependent, let’s listen to it playing in the Arrange window.

8 In the Transport bar, click the Cycle button.

9 Play the project, listening to the result.

You should hear a sweeping, pulsing, swelling drumbeat that is quite transformed from the original.

10 Stop the project.

While the loop was playing, you might have noticed the EXS24 distorting, and the channel volume pushing well into the red. This is because of the extra gain introduced by boosting the Drive and Resonance controls. You can buy back a little headroom by lowering the EXS24’s own Volume control, located at the far right of the interface.
11 Drag the Volume knob downwards to a value of –7 db.

Using Groups
In the EXS24 Instrument Editor, zones can be organized into groups in order to apply common parameters to multiple zones simultaneously. Groups contain many of the same parameters used in zones, but they also offer some unique parameters of their own, such as the ability to offset both the filter settings and the envelopes. This allows you to create, for example, different cutoff and resonance values for different zones.

In the sampler instrument you created, the low-pass filter cuts out the high frequencies of all samples. By using groups, you can, in effect, apply a different cutoff frequency for just the snare hits.

1 On the EXS24 interface, click the Edit button.

The EXS24 Instrument Editor opens.

2 From the local menu, choose Group > New Group.

A new group is created, Group #2, which appears within the Zones column.
NOTE ► In addition to the newly created group, the Zones column displays All Zones, Ungrouped, and Basic Drums groups. The All Zones group contains all zones, regardless of their assignment. The Ungrouped group contains only zones that have no assignment whatsoever. The Basic Drums group, created by default when you imported the samples into the EXS24 Instrument Editor, contains all of the slices created by using the Convert Regions to New Sampler Track setting.

3 In the Zones column, double-click the name of the new Group (Group #2), and enter Filter. Press Return.

To display the parameters for the newly created group, you need to switch to Groups view.

4 Click the Groups view button.

The group parameters are displayed.
NOTE  ▶ By default, the editor only displays some of the group parameters, while hiding others. As you did with zones in an earlier exercise, you can select the parameters you want displayed within the View menu while in Groups view.

5  In the Filter Offsets parameters, double-click the Cutoff field and enter –5. Press Return.

This will lower the filter cutoff frequency for any zone assigned to this group.

Now that you created and modified the group, it's time to assign the zones to the new group. This is done back in the Zones view.

6  Click the Zones view button.

You might be asking yourself “where did the zones go?” Not to worry; you are currently viewing the Filter group, which as of yet does not have any zones assigned to it.

7  Click the All Zones group.

All zones are displayed.

Zones can be easily assigned to groups by dragging and dropping onto the groups within the Zones column.

8  Command-click the zones mapped to D3 and G3 to select them.

9  Drag the selected zones to the Filter group.
10 In the Zones column, select the Filter Group.

The two zones you added are displayed.

11 Play the project, listening to the result.

The snare samples mapped to D3 and G3 have a slightly different filter cutoff frequency, changing the sound.

**Routing Individual Sounds for Processing**

As if the options offered by the EXS24’s modulation and filter sections weren’t enough, Logic allows you to further process the sound emanating from the EXS24 by inserting plug-ins in the signal chain. When you do this, the entire EXS24 signal is processed. Although this normally isn’t a problem, there are some instances when you want to apply separate processing to individual zones within a sampler instrument.

To do this, you need to isolate the zone or group on its own mixer channel for individual processing. Fortunately, the EXS24 allows you to route individual sounds through separate virtual “outputs” to accomplish just that. These routings are selected by the Output menu in the Mixer parameters in either the Zone or Group parameters.

1 Click the Groups view button.

2 Click the Output field for the Filter group (it currently displays “Main”), and choose 3-4.
NOTE ► The first five selections represent stereo routings, and the last six selections represent mono.

3 In the local Instrument menu, choose Save.

To use this special function, you need to instantiate the EXS24 as a multi-output instrument. So far you’ve been working with the EXS24 as a stereo instrument and have done quite a bit of work modifying the zones and groups. Luckily, Logic allows you to keep all of the current settings when changing from stereo to multi-output instantiations.

NOTE ► For any software instrument, all settings and content contained in a software instrument will be transferred when switching modes (mono, stereo, multi-output, and 5.1).

5 At the bottom of the Arrange window, click the Mixer button to open the Mixer.

6 On the Basic Drums channel strip (Track 4), click-hold the Instrument slot to open the Instrument Plug-in menu and choose EXS24 (Sampler) > Multi Output (5xStereo, 6xMono).

The EXS24 interface opens after reloading the associated samples and current settings.

7 If necessary, move the EXS24 window so you can see the EXS24 Basic Drums channel strip (Track 4).

8 Just under the Solo button, click the small plus button (+) on the EXS24 Basic Drums channel strip (Track 4).
A new Aux 1 channel strip is created immediately to the right of the EXS24 Basic Drums channel strip (Track 4). This will be the receiving channel for our Filter group. By default, Logic creates an aux channel with the default stereo input of 3-4 for the associated multi-output instrument (in this case, the EXS24).

9 Play the project, stopping after you’ve had a chance to observe the output of the Aux 1 channel.

The zones assigned to the Filter group play through the Aux 1 channel, while the remaining zones play through the EXS24 Basic Drums channel (Track 4).

**Tip** This technique works well for drum sampler instruments that need separate compression, EQ, and ambience treatments for individual drums (kick, snare, and so on).

Now that the snare slices are isolated on their own mixer channel, you can insert plug-ins or use send effects for further processing and not affect the other slices in the sampler instrument. In the following steps, you will send the snare slices through a simple Echo plug-in to create rhythmic echoes.

10 Click the Aux 1 channel’s top insert slot, and choose Delay > Echo >Stereo.

The Echo plug-in is instantiated, and its interface window opens.
11 Click the Time menu, and choose 1/8T.

This sets the repeat time to eighth-note triplets.

12 Drag the Wet slider down to 23%.

This will lower the volume level of the repeats so as not to overpower the original signal.

13 Play the project, listening to the effect of all of the EXS24 programming you’ve done in the last few exercises.

The result is a surging, shuffling, processed drum loop, quite abstracted from the original audio file.

14 From the preset menu, choose Save Setting As.

15 In the file selector dialog, name the preset Vox Note and then click Save.

To give perspective on just how much has been changed, let’s finish by listening to the original loop.

16 Close both the Echo and EXS24 windows.

17 Close the Mixer.

18 Using the Mute tool, select the Basic Drums.1 region on Track 3, unmuting the original region.
19 In the Transport bar, click the Solo button to enable it.

20 Play the project.

21 While the project is playing, select the original Basic Drums audio track (Track 3) and EXS24 Basic Drums software instrument track (Track 4) alternatively, soloing them.

22 Stop the project.

23 In the Transport bar, click the Solo button to disable it.

**Lesson Review**

1. Individual samples are referenced and mapped within what?
2. What contains the settings for how a sample will be played back, including key ranges?
3. Which tuning parameter in the EXS24 Instrument Editor would be used to tune by cents, Coarse or Fine?
4. Are loop points set within zones or groups?
5. What parameter in the EXS24 Instrument Editor is used to smooth out transitions between the end points and start points of a loop?
6. How are groups used in the EXS24 Instrument Editor?
7. Are filter and envelope offsets set within zones or groups?
8. What do multi-output instruments do?

**Answers**

1. Samples are mapped within sampler instruments.
2. Zones contain the settings for how a sample will be played back, including key range.
3. The Fine parameter is used to tune by cents.
4. Loop points are set within zones, as they refer to specific samples.
5. The Xfade parameter allows you to assign a crossfade between the end and start points of a loop, making it smoother.

6. Groups are used to assign common parameters to multiple zones.

7. Filter and envelope offsets are set within groups.

8. Multi-output instruments (such as Ultrabeat and EXS24 mkII) can route individual sounds to separate channel strips for isolation or further processing.
Index

A
All Objects layer, Environment, 444–445
Alternate tool, 30–31
saving to screensets, 31
Apple Loops
with Touch Tracks
Environment object, 473–477
Apple Loops Utility, 48
automatic pitch shifting, 49
octave transposition, 53
saving Apple Loops, 55–56
Sensitivity slider, 54
tags, 49–51
Tempo slider, 52–53
versus Time and Pitch
Machine, 56
transients, 51–55
Apple QuickTime, 536
arpeggiating chords, 313–314
Arpeggiator Environment object, 449–453
Arrange area
key focus, 20
maximizing workspace, 16–19
tool click zones, 34
Tool menu, 29
Arrange view, Mixer, 336–339
arrangements
global editing, 221–227
inserting space, 225–227
playback, Cycle mode, 207–211
playback, Play From Left
Window Edge, 206–207, 209
playback, prioritizing, 203–205
playhead, moving with Bar
ruler, 201
playhead, positioning with
Marquee tool, 202–203
playing, 200–203
switching between, 241–243
arrangements and folders
for alternates, 231–234
editing regions, 235–237
muting/unmuting, 241–243
packing, 227–228
subdividing, 229–231
unpacking, 243–244
working inside, 237–241
arrangements and markers
coloring, 217–219
creating, 211–212
creating, from selected
regions, 215
creating, on fly, 213
creating, with Pencil tool,
214–215
creating, with Period and
Comma keys, 213
editing positions, 215–217
Marker Lists, 220–222
multiple arrangements,
241–243
naming, 217
navigating with, 219
audio editing
clicks, fixing in Sample Editor,
253–256
comps with Quick Swipe
Comping, 259–263
groups, 264–266
groups, activating/
deactivating, 266–267
groups, phase-locked, 267–272
groups, quantizing audio,
270–272
Soundtrack Pro 3, 279–289
Soundtrack Pro 3, file
preparation, 275–277
Soundtrack Pro 3, Frequency
Spectrum view, 281–285
Soundtrack Pro 3, user
interface, 277–279
Soundtrack Pro 3, viewing in
Logic, 289–290
take folders, 257–259
transients, with Marquee
selections, 272–275
transitions, with crossfades,
248–253
automation of aux channels
hardware control surfaces,
394–410
scaling values, 391–392
snapping data to timeline,
387–389
tracks, adding, 384–387
tracks, applying automation,
392–394
tracks, copying data between,
389–390
Automation Quick Access feature, 397
Auto-select Channel Strip, 58, 254
Auto-Set Locator feature, 210
aux channel automation
hardware control surfaces,
394–410
scaling values, 391–392
snapping data to timeline,
387–389
tracks, adding, 384–387
tracks, copying data between,
389–390
aux channels
as submixes, 358–361
Avid’s Pro Tools 8. See Pro Tools 8
backup/restore settings
key commands, 38
with MobileMe account, 41–42
project templates, 38
Beat Mapping track, 93–95
audio regions, 100–101
checking, 99
MIDI regions, 95–99
Body EQ, Sculpture, 171–172
Bonjour
network access to settings, 42–43
Bounce in Place feature, 376–381

Cable Switcher Environment object, 464–469
Channel EQ plug-in, 347
relocating, 348–359
surround sound, 428–431
channel strips
filters, 339–340
importing with project data, 334–336
Mixer, All view, 340–341
Mixer, Single view, 342
networks, settings, accessing, 40
networks, settings, sharing, 42–44
chord charts, 505–509
chord grids, 509–513
Chord Memorizer Environment object, 453–455
Click & Ports layer, Environment, 445, 447–448, 453
clicks and pops
fixing in Sample Editor, 253–256
fixing with crossfades, 248–250
collections, 10
Color window, 258–259
Compose collection
Empty Project, 10
Compressor plug-in, 347–348
Output Distortion menu, 350
relocating, 348–359
Controller Assignments window
Expert view, 399–400, 403
fader banks, changing, 408–410
Learn Mode, 398, 401–402
modes, adding, 405–406
modes, switching, 407–408
zones, adding, 405–406
controllers. See hardware control surfaces
Convert Regions to New Sampler Track, 134–135
Copy Value to All Following Events command, 296
Crossfade tool, 250
crossfades, 248–250
applying to multiple regions, 251–253
Curve parameter, 253
Customize Toolbar dialog, 14–15
Customize Transport bar dialog, 15
Cycle mode
playback, 207–211
Skip Cycle, 235
disturbers and exciters, Sculpture, 169
Dolby Digital (AC3) files, 437–439
Down Mixer plug-in
surround sound, 434–435
Drum Replacement/Doubling feature, 290–296
drums. See also Ultrabeat
mapped instruments, 517–523
DVD-Audio discs, 435–437
effects processors, 373–376
envelope generators
EZ2 Synthesizer, 122–124
Sculpture, 173–175
Ultrabeat, 184–185
Environment
layers, All Objects, 444–445
layers, Click & Ports, 445, 447–448, 453
objects, Arpeggiato, 449–453
objects, Cable Switcher, 464–469
objects, Chord Memorizer, 453–455
objects, creating, 447–448
objects, Delay Line, 455–458
objects, Monitor, 448–449
objects, Physical Input cabling to Sequencer Input, 446–447, 453
objects, Touch Tracks, 469–473
objects, Touch Tracks, with Apple Loops, 473–477
objects, Transformer, 459–464
signal chains, 458–459
Tool menu, 30
Eraser tool
floating Tool menu, 32
Event List
editing, 294–296
Tool menu, 29
Event Parameter box, 490
Length, 491
Style, 505
Explore collection
Empty Project, 10
EXS24 Instrument Editor and sampler instruments, 136–139
EXS24 Parameter window, 144–146
filter and modulation options, 150–153
loop points, 140–144
routing sounds for processing, 156–160
zones, groups of, 153–156
zones, multiple, from transients, 146–150
EXS24 tracks
creating, 134–136
EZ2 Synthesizer
filters, 114–118
oscillator modulation, 122–124
envelope generators, 122–124
oscillator modulation, FM, 111–112
oscillator modulation, LFOs, 119, 120–122
oscillator modulation, ring modulation, 112–113
oscillator modulation, router, 119
oscillator modulation, synchronization, 113–114
oscillator modulation, vector envelope generators, 125–129
oscillator waveforms, 107–110
output/processing section, 130
user interface, 106–107

F
Fade parameters, 249–253
Fade Tool Click Zones option, 34
filters
EXS24 Instrument Editor, 150–153
EZ2 Synthesizer, 114–118
Sculpture, 171
Ultrabeat, 191–194
Finger tool, 221
flex markers, 73–77
Flex Mode menu, 82
Monophonic mode, 70, 86
Rhythmic mode, 83
Slicing mode, 81
Speed mode, 89
Tempophone mode, 89
flex time, 68–73
groove templates, 85–89
quantization, 79–82
Flex view, 72
FM (frequency modulation), 111–112
formants, 59–60
frequency modulation (FM), 111–112
Frequency Spectrum view, 281–285

G
Go To Position command, 213
groove templates, 85–89
Group Clutch feature, 266–267, 401
Group Settings window, 265, 268–270
groups, 264–266
activating/deactivating, 266–267
channels, assigning to, 351–353
channels, post-pan sends, 368
disabling, 353–354
phase-locked, 267–270
quantizing audio, 270–272
of tracks, 13
of zones, 153–156

H
hardware control surfaces
channel controls, assigning, 400–402
channel controls, mapping to parameters, 402–404
Controller Assignment window, Expert view, 399–400
fader banks, 408–410
modes, creating, 404–406
modes, switching, 407–408
plug-in parameters, 397–399
transport controls, assigning, 395–397
zones, creating, 404–406
harmonic correction
Time and Pitch Machine, 59–61
Hyper Editor Tool menu, 29

I
Import Audio icon, 14–15
Import Project Settings dialog, 38–39
Import Settings dialog, 39
importing media for synchronization, 546–547
audio, 550–551
broadcast WAVE, 548–549
XML, 547–548
Inspector
viewing/hiding, 19
I/O plug-in, 373, 375–376

J
Junction tool, 218

K
key commands
assignments, caution, 24
assignments, making, 25–28
assignments, viewing, 23–25
backups, 38
key labels, 26–27
key-command-only functions, 28–29
networks, settings, accessing, 40
networks, settings, sharing, 42–44
key focus, windows and areas, 20–21

L
LFOs (low-frequency oscillators)
EZ2 Synthesizer, 119, 120–122
Sculpture, 173
Ultrabeat, 184, 190–191
Library, 13
locators
inserting space between, 225–227
navigating arrangements, 219
repeating sections between, 223–225
Set Locators by Next or Previous Marker and Enable Cycle commands, 219, 222, 224
setting, with Cycle mode, 207–211
locking screensets, 21
locked versus unlocked, 22–23
Logic Pro 9
exporting files to Pro Tools 8, tempo-marker maps, 566–567
importing audio files, 573–574
Logic Pro 9,
exporting files to Pro Tools 8, tracks as audio, 562–565
Loop Mode menu, 127
loop points, EXS24 Instrument Editor, 140–144
low-frequency oscillators, 120–122.
See LFOs

M
mapped instruments, 517–523
Marker List View menu, 544–545
markers
coloring, 217–219
creating, 211–212
creating, from selected regions, 215
creating, on the fly, 213
creating, with Pencil tool, 214–215
creating, with Period and Comma keys, 213
editing positions, 215–217
Marker Lists, 220–222
naming, 217
navigating with, 219
Set Locators by Next or Previous Marker and Enable Cycle commands, 219, 222, 224
Marquee selections, 78–79
isolating selections for editing, 272–275
Marquee tool
playhead, positioning, 202–203
Marquee Tool Click Zones option, 34–35
Media area
Library, 13
MIDI controller
channel controls, assigning, 400–402
channel controls, mapping to parameters, 402–404
fader banks, 408–410
modes, creating, 404–406
modes, switching, 407–408
zones, creating, 404–406
MIDI editing
aliases, 300–302
transform sets, 319–321
transform sets, applying, 327–328
transform sets, creating functions, 321–327
MIDI events
selecting for editing, 317–318
separating, 328–330
MIDI regions
altering articulation, 307–308
delays, 306–307
gate time, 307–308
Marquee selections, 275
notation, preparing for, 513–515
notation, viewing data, 515–517
rhythm with quantization, 307–308
touch track objects, 469–477
transposing, 303–304
velocities, 304–306
velocities and length, 315–316
Mixer
Arrange view, 336–339
group feature, 264–272
key focus, 20
maximizing workspace, 16–19
Notes area, 342–344
Options, Create New Auxilliary Channel Strips, 374
plug-ins, changing locations, 348–350
plug-ins, switching in window, 346–348
View, Add Signal Flow Channel Strips, 337
View, Colors, 337
Mixer channel strips
All view, 340–341
filters, 339–340
Single view, 342
stereo tracks, 344–346
Mixer groups
channels, assigning to, 351–353
disabling, 353–354
MobileMe account
settings, backing up/restoring, 41–42
settings, sharing, 42–44
modulation
EXS24 Instrument Editor, 150–153
EZ2 Synthesizer routers, 119
Sculpture, 173–175
Monitor Environment object, 448–449
Monophonic mode, 70, 86
Morph Pad, Sculpture, 173–175, 178
Multichannel Gain plug-in
surround sound, 431–434
MultiMeter plug-in, 432
N
navigation
plug-ins, switching in windows, 346–348
networks
settings, accessing, 40
settings, sharing, 42–44
New Track dialog, 10–11
groups of tracks, 13
inputs and outputs, 12
Noise Gate plug-in, 364–367
notation with Score Editor, 482–483
chord charts, 505–509
chord grids, 509–513
drums, mapped instruments, 517–523
MIDI regions, preparations, 513–515
MIDI regions, viewing data, 515–517
notes, adjusting length, 490–492
notes, dragging, 488–490
notes, editing with step input, 492–494
score sets, creating, 524–527
score sets, creating parts for printing, 527–532
staff styles, 494–496
staff styles, polyphonic, 496–502
text, 502–505
transcribing performances, 513
Notator, 481
Note On Random modulators, Sculpture, 173
Notes area, Mixer, 342–344
O
Object Parameter box
Direction, 451–452, 463
Random, 452
Range, 466
Repeats, 456
Velocity, 452
octave transposition, 53
oscillator modulation, EZ2
Synthesizer
envelope generators, 122–124
FM, 111–112
LFOs, 119, 120–122
ring modulation, 112–113
router, 119
synchronization, 113–114
vector envelope generators, 125–129
oscillator waveforms, EZ2
Synthesizer, 107–110
Output Distortion menu, Compressor plug-in, 350
P
parallel compression, 367–371
parallel routing, 362
Pencil tool, 22
  alternate tools, 30–31
performance transcriptions, 513
Phase-Locked Audio checkbox, 266, 269
phase-locked groups, 267–270
Physical Input Environment object, 446–447, 453
Piano Roll Editor
  beat mapping, 99
  MIDI events, 317–321
  MIDI regions, 302, 310
  Tool menu, 30
Pickup Clock command, 552–553
Pitch Correction plug-in, 63–66
  automating, 66–68
pitch shifting. See also Time and Pitch Machine
  Apple Loops Utility, 49
  with harmonic correction, 59–61
  Time and Pitch Machine, 57–59
Play Cycle option, 205, 207
Play From Left Window Edge option, 206–207, 209
Play From Selected Region option, 203–205
Play Marquee Selection option, 203, 205
playback
  Cycle mode, 207–211
  Play From Left Window Edge, 206–207, 209
  prioritizing, 203–205
playheads
  moving with Bar ruler, 201
  positioning with Marquee tool, 202–203
  prioritizing playback, 203–205
plug-ins
  changing locations, 348–350
  extented parameters, 350
  network settings, accessing, 40
  network settings, sharing, 42–44
  switching in window, 346–348
Pointer tool
  alternate tools, 30–31
  floating Tool menu, 32
  polyphonic staff styles, 496–502
post-pan sends
  parallel compression, 367–371
Prelisten button, 254
Pro Tools 8
  exporting of Logic Pro 9 files to, 562–567
  importing Logic Pro 9 projects into, 567–573
  Reverse, 287
  Space Designer, 286
Produce collection
  Empty Project, 10
  production notes
    Mixer, 342–344
Project Settings window
  Audio settings, 541–542
  General, Bar Position, 539
  General, Frame Rate, 539
  General, Plays at SMPTE, 539
  Video settings, 540–541, 543
project templates. See also templates
  backups, 38
  opening automatically, 36–38
  saving, 36
projects
  creating, 36–38
  opening, 36–38
  property tags, 49–51
quantization
  flex time, 79–82
  phase-locked editing, 270–272
Quick Swipe comping, 259–263
Randomize function, EZ2
Synthesizer, 131
Region
  Bounce Regions in Place, 377
  Name Regions by Tracks/
    Channel Strips, 294, 330
  Repeat Regions, 301
Region Parameter box, 250
  Delay, 306–307
  Dynamics, Fixed, 305
  Fade type, EqP (Equal Power), 249, 251
  Gate Time, 307–308
  Loop, 306
  Q-Flam, 313–314
  Q-Length, 315–316
Q-Range, 312–313
Q-Strength, 311–314
Q-Swing, 311
Quantize, 271, 306, 315
Q-Velocity, 315–316
Transpose, 303–304
Velocity, 305
Relative Threshold control, 292
Repeat Section command, 223
reverbs
  plug-ins, 375
  reverse, 287–289
Rhythmic mode, 83
ring modulation, 112–113
rubato
  beat mapping, 93–101
Sample Editor
  clicks and pops, fixing, 253–256
  preferences, 61
  Time and Pitch Machine, 58–59
  Tool menu, 30
  transient markers, 82–85
sampler instruments and EXS24
  Instrument Editor, 136–139
  creating sampler instruments, 134–136
  EXS24 Parameter window, 144–146
  filter and modulation options, 150–153
  loop points, 140–144
  routing sounds for processing, 156–160
  zones, groups of, 153–156
  zones, multiple, from transients, 146–150
Scissors tool, 258
  floating Tool menu, 32
Score Editor
  Tool menu, 29
  Score Editor notation, 482–483
    chord charts, 505–509
    chord grids, 509–513
    drums, mapped instruments, 517–523
    MIDI regions, preparations, 513–515
MIDI regions, viewing data, 515–517
notes, adjusting length, 490–492
notes, dragging, 488–490
notes, editing with step input, 492–494
score sets, creating, 524–527
score sets, creating parts for printing, 527–532
staff styles, 494–496
staff styles, polyphonic, 496–502
text, 502–505
transcribing performances, 513
score sets, 524–532
screensets
Alternate tool, saving to, 31
channel strip settings, 341
custom, 16–18
Environment window, 444
importing, 38–39
locked versus unlocked, 22–23
locking, 21
maximizing workspace, 16–21
Score Editor, 482
screen real estate, 16
Sculpture
modulation, 173–175
Morph Pad, 173–175, 178
saving sounds as presets, 175–176
sound processing, 171–173
string, 165–166
string, objects, 166–171
string, pickups, 171
user interface, 164–165
Sensitivity slider, Apple Loops
Utility, 54
Sequencer Input object, 446–447, 453
serial processing, 358–361
Set Locators and Play command, 207, 210
Set Locators by Next or Previous Marker and Enable Cycle commands, 219, 222, 224
Set Marquee End to Previous Transient command, 274
side chaining, 362–367
Ultrabeat, 188
signal chaining
Environment, 458–459
signal flow
Bounce in Place feature, 376–381
effects processors, 373–376
I/O plug-in, 373, 375–376
parallel compression, 367–371
side chaining, 362–367
software instrument tracks, rendering as audio, 380–381
submixes, applying send effects to, 361–362
submixes, aux channels as, 358–361
signal routing, 363
Single view, Mixer, 342
Skip Cycle feature, 235
Slicing mode, 81
SMPTE time code, 538–541
locking, 549–550
Pickup Clock command, 552–553
positioning events on timeline, 551–552
software instrument tracks
rendering as audio, 380–381
Sound Settings dialog, 555–556
soundtrack delivery, 554–555
dubbing stems, 556–558
exporting audio to movie, 555–556
Soundtrack Pro 3
editing files, 279–281
editing files, multiple, 285–289
editing files, viewing in Logic, 289–290
file preparation, 275–277
Frequency Spectrum view, 281–285
Space Designer, 280, 284
surround sound settings, 426–427
speed fades, 89–91
Speed mode, 89
Split by Playhead button, 14–15
staff styles, 494–496
polyphonic, 496–502
step input, 492–494
Step mode
Ultrabeat, 194–197
stereo tracks
Mixer channel strips, 344–346
.stmp files versus .stap files, 277
string, Sculpture, 165–166
objects, 166–171
pickups, 171
submixes
aux channels as, 358–361
send effects, applying to, 361–362
Surround Panner, 418–420
balancing stereo, 421–424
center and LFE levels, 420–421
Surround sound, 416–418
audio interface output assignments, 414–415
Dolby Digital (AC3) files, 437–439
DVD-Audio discs, 435–437
effects, multi-channel, 425–428
effects, multi-mono insert, 428–431
plug-ins, Down Mixer, 434–435
plug-ins, Multichannel Gain, 431–434
project format, 416
Swap Left and Right Locator command, 235
synchronization, 113–114, 536–537
Apple QuickTime, 536
audio configuration, 541–542
media, importing, 546–547
media, importing audio, 550–551
media, importing broadcast WAVE, 548–549
media, importing XML, 547–548
movies, detecting cuts, 545–546
movies, markers for spotting, 543–545
movies, opening, 538
navigating with video, 542–543
SMPTE time code, 538–541
SMPTE time code, locking, 549–550
SMPTE time code, Pickup Clock command, 552–553
SMPTE time code, positioning events on timeline, 551–552
soundtrack delivery, 554–555
soundtrack delivery, dubbing stems, 556–558
soundtrack delivery, exporting audio to movie, 555–556
synthesis. See ES2Synthesizer

T
Tab key
- key focus, shifting, 20–21
tags, 49–51
take folders, 257–259
- creating comps, 259–263
templates. See also groove templates; project templates
custom, 10
premade, 10
premade, customizing with region parameters, 315–316
Templates pane
- Empty Project button, 10
tempo
- beat mapping, 93–99
varispeed, 91–93
Tempo Alternative menu, 98, 99–100
Tempo slider, Apple Loops Utility, 52–53
Tempohone mode, 89
Test Oscillator plug in, 363–366
text in notation, 502–505
Time and Pitch Machine. See also pitch shifting
- accessing, in Arrange area, 61–63
versus Apple Loops Utility, 56
pitch transposition, 57–59
pitch transposition, with harmonic correction, 59–61
Timing Offset parameter, 293
Toggle Group Clutch command, 167
tool click zones, 34–35
Tool menus
- accessing quickly, 31–32
alternate tools, 30–31
alternate tools, saving to screensets, 31
Arrange area, 29
Environment, 30
Event List, 29
floating Tool menu, 31–32
hard-wired commands, 32–33
Hyper Editor, 29
Piano Roll Editor, 30
Sample Editor, 30
Score Editor, 29
two-button mouse, 35
toolbar
- customizing, 14–15
global, 15
Touch Tracks Environment object, 469–473
Touch Tracks Environment object, with Apple Loops, 473–477
Transform window, 322–328
Transformer Environment object, 459–464
transient markers
Sample Editor, 82–85
transients, 51–55
- beat mapping, 100–101
transitions
- clicks and pops, fixing, 253–256
crossfades, 248–250
crossfades, applying to multiple regions, 251–253
Marquee selections for editing, 272–275
Quick Swipe comping, 259–263
Transport bar
- customizing, 15–16
Trigger Note assignment, 294

U
Ultrabeat
- Assignment section, 181–182
bitcrusher, 191–194
filters, multimode, 191–194
sample loading, 189–191
side chaining, 188
sounds, hi-hat, 187–188
sounds, kick drum, 182–184
sounds, snare drum, 185–186
Step mode, 194–197
user interface, 180
user preferences
toolbar buttons, adding, 15

V
varispeed, 91–93
vector envelope generators, EZ2 Synthesizer, 125–129
Vector Mode menu, 125
Voice Separation tool, 501–502

W
Waveform Editor, 279, 285
Waveshaper, Sculpture, 171

Z
zones, EXS24 Instrument Editor
- groups of, 153–156
multiple, from transients, 146–150